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Introduction
The Microsoft® Outlook® messaging and collaboration client lets you use folders
to store a wide variety of data items, from e-mail and appointments to contacts 
and sticky notes. As you use Outlook you may find that you want more 
sophisticated tools to manage your Outlook information. The purpose of this 
white paper is to explain the various data file management features in Outlook, 
and to recommend the best solutions to accomplish your goals.

This paper will provide you with an understanding of how you can manage your 
folders using the following methods:

 Backing up your data for safe storage

 Cleaning old items out of the folders you use every day, without losing 
information

 Keeping information on two computers in sync 

 Sharing information with other users 

Outlook Data files
The Outlook data file is the file that contains all of your personal Outlook folders:
Inbox, Calendar, Contacts, etc. Depending on your configuration, Outlook will 
use one of three types of file:

 Personal Folders file (.PST file). The PST is a general-purpose file 
that resides locally on the user’s computer. All users without a Microsoft 
Exchange Server keep their Outlook folders in a PST.

 Exchange Server Messaging Store (EMS). The EMS is a “file” that 
resides on a central Exchange Server. EMS users log into the server and 
access their information over the network. (Exchange Server users also 
have access to Public Folders that they can use to store shared 
information.)

 Exchange Server Offline Folder file (.OST file). When Exchange 
Server users need to work with their Outlook information while not 
connected to the server (on a laptop, for example), they can keep a local 
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copy of their information in an OST file and synchronize it with the server. 
When the user connects to the server, any changes made in the OST will be
uploaded to the server, and vice versa.

Users of Outlook can have several data files open at once. For example, 
Exchange Server users might have their EMS open, but also have PSTs open that
they use to store old data that has been archived. You can view all of the data 
files that you currently have open in the Folder List:

Figure 1. The folder list (choose Folder List from the View menu) shows the data files that 
are currently open. This illustration shows two data files (the “Archive Folders” PST and 
the EMS mailbox) that a typical Exchange Server user might see.
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Backup
Keeping copies of your information is very important. It will assure that if for 
some reason you should lose or delete information you have a copy you can go 
back to find that information. Outlook provides you with ways to back up your 
Personal folders and your Exchange folders.

Backing Up Your Personal Folder File (PST)

Using the Personal Folder Backup Add-in

The Personal Folder Backup add-in makes it easy to backup your PST files. You 
can choose which PST files you want to backup, where you want to save your 
backup files, and how often you want to be reminded to back up. Outlook takes 
care of the rest.

Figure 2. The Personal Folder Backup Options dialog box (File|Backup|Options) lets you 
choose what, where, and when to back up. 

The Personal Folder Backup copies the PST file directly to a backup location—
there is no separate backup file format.

Note  Personal Folder Backup is currently in its beta phase. It will not ship with 
Outlook 2000, but will be available for download on the Microsoft Outlook Web 
site (http://microsoft.com/outlook) soon after Outlook 2000 is released.

http://microsoft.com/outlook
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Backing Up Your Outlook Data File (PST) Without Personal Folder Backup

If you need to back up a PST file and you don’t have the Personal Folder Backup 
add-in, you can back it up just as you would any other file on your computer. At 
regular intervals, simply use the Windows® Explorer (or any backup program) to
copy your PST file to a backup location. This is generally the fastest way to back 
up your Outlook data.

By default, your PST file is named Outlook.pst and is stored in Outlook’s Local 
Settings directory (for example, C:\Windows\profiles\username\Local Settings\
Application Data\Microsoft\Outlook\ on multi-user computers, or C:\Windows\
Local Settings\Application Data\Microsoft\Outlook\ on single-user computers). 
You can always find out the name and location of any PST file by right-clicking 
on its root folder in the Folder List, choosing Properties, and then going to the 
Advanced tab.

You must exit Outlook before you can copy or otherwise access a PST file.

Backing Up Your Outlook Data File (EMS)

If your information is on an Exchange Server, your data is most likely being 
automatically backed up by the server administrator. If you still want a local 
copy of your data, you can always keep synchronized copies of your important 
Exchange Server folders on a local OST. If you want to write out a copy of your 
entire EMS to a PST file, you can use the Export feature to export copies of your 
root folder and all of its subfolders. 

Note  If your Exchange Server data is ever lost and has not been backed up by 
your server administrator, but you still have a copy of it in your local OST file, do
not synchronize with your Exchange Server. If you do this, your local data will be
removed in the synchronization process. In order to restore your data, you will 
need to start Outlook offline (working from your OST), Export your data into a 
PST, and then Import the data from the PST back into your Exchange Server 
folders.

Backing Up Individual Folders

If you only want to back up certain folders, you can copy them to a backup PST 
using the Export feature. This method will generally take longer than simply 
backing up your entire PST file, but by only choosing certain folders, your 
backup file will be much smaller (which can be especially useful if you need to 
back up your data to a floppy disk). This method also lets you filter the items 
that you export; for example, you can choose to export only items that have 
been modified within the past week.

From the File menu, choose the Import and Export command. In the Import and 
Export Wizard, choose “Export to a file,” then in the next screen choose to 
export to a “Personal Folder File (.pst)”. In the next screen, you can choose 
which folder/subfolders to export, and which PST to export them to.
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Figure 3. The Export feature lets you copy folders to a backup PST.

When an item is exported into another PST, Outlook is actually exporting a copy 
of that item. (The same is true when an item is imported.) Each Outlook item 
has a unique EntryID that identifies it—when a copy of an item is made, that 
copy has a different EntryID. The Contact Activity Tracking feature make use of 
the EntryID to link one item to another, and when this EntryID changes, the link
between the two items will break.

Restoring Backup Files

Depending on how much information you wish to recover, there are three ways 
to restore your backup data.

Recover a few items. If you simply need to recover a few items that have been
accidentally deleted or changed, you can do the following:

1. Open your backup file. On the File menu, point to Open, then select 
Personal Folders File (.pst). Find your backup PST file and click OK.

2. If it isn’t already visible, show the Folder List (from the View menu, 
choose Folder List).

3. Find the desired items in your backup file, and either move or copy them 
into your original folders.

4. Close your backup file (right-click on the root folder and choose Close).

Recover a large number of items. If you need to recover a larger number of 
items, or an entire folder, you can use the Import feature (File | Import and 
Export) to copy items from your backup file into your original file. You can set a 
filter for the import, and you can choose whether or not to replace duplicate 
items.
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Recover your entire PST. If your original PST file has been accidentally 
deleted, completely corrupted, or otherwise destroyed, you can replace it with 
your backup PST. The best way to do this is:

1. Quit Outlook.

2. Using Windows Explorer, find your damaged PST file and rename it.

3. Make a copy of your backup PST file, and give it the name of your original
PST file.

4. Run Outlook. (In some cases you may need to set the newly copied PST 
as your default data file.)

Backing Up Your Other Outlook Settings

Listed below are additional files that Outlook uses to save user settings. These 
are included for the sake of completeness, but in most cases you will not need to
spend the time to back up these files because they take only a few minutes to 
re-create. If you are moving to a new computer, however, and your settings are 
especially detailed, you may find it useful to copy these files to your new 
computer.

File Filename Directory†

Command Bar 
Customization 
file

Outcmd.dat \Application Data\Microsoft\Outlook\

If you have customized your menu and/or toolbars, the 
customization settings are stored in the Outcmd.dat file

Favorites files Profilename.fav \Application Data\Microsoft\Outlook\

Outlook records your Outlook Bar settings in a .fav file. If you 
have more than one Outlook profile, you will have a separate .fav
file (profilename.fav) for each profile.

Rules Wizard 
files

Profilename.rwz \Application Data\Microsoft\Outlook\

Outlook records your local Rules Wizard settings in a .rwz file. If 
you have more than one Outlook Profile, you will have a separate
.rwz file (Profilename.rwz) for each profile.

Nickname files Profilename.nick \Application Data\Microsoft\Outlook\

This file remembers what “nicknames” you have typed in the To:
line of e-mail messages and matches them to actual e-mail 
addresses. If you have more than one Outlook Profile, you will 
have a separate .nick file (Profilename.nick) for each profile.

Signature files *.rtf, *.htm, *.html, 
*.txt

\Application Data\Microsoft\
Signatures\

Stationery files *.* \Application Data\Microsoft\Stationery

Personal 
Address Book

*.pab \Local Settings\Application Data\
Microsoft\Outlook
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Only users with Corporate/Workgroup support will have this file, 
which is usually named mailbox.pab. The PAB contains

† The Application Data directory is typically located in C:\Windows\Application 
Data on single-user computers, and in C:\Windows\Profiles\username\
Application Data on multi-user computers. 

The Local Settings directory is typically located in C:\Windows\Local Settings on 
single-user computers, and in C:\Windows\Profiles\username\Local Settings on 
multi-user computers.

Moving to a New Computer

The steps required to move to another computer depend on what type of mail 
support you have. (To find out what type of mail support you have, go to the 
Help menu and choose About Microsoft Outlook. The second line of text in the 
About Microsoft Outlook dialog box tells you what type of mail support you 
have.)

Internet Mail Only support. Users with Internet Mail Only support will need to 
take the following steps to move to a new computer:

1. Install Outlook on the new computer (but do not run the application yet).

2. Copy your default PST file. This file is usually named Outlook.pst, and is 
located in your default Outlook directory. 

3. Copy any other PST files that you use.

4. Copy your Outlook settings files.

5. Run Outlook and re-create your account settings. When you run Outlook 
on the new computer for the first time, it will provide a wizard that will 
help you do this. You can look at your old account settings by choosing 
Accounts from the Tools menu on your old computer.

6. Open your PST files. Choose Open from the File menu to open all of the 
files that you copied in step 3.

Set your default PST file. If your old default file is not named Outlook.pst, 
then Outlook will have created a new blank Outlook.pst for you and will have 
set it as the default PST. You will need to set your old PST as the new 
default.

Corporate/Workgroup support. These users will need to take the following 
steps to move to a new computer:

1. Install Outlook (but do not run the application yet).

Copying your EMS file is not necessary. If you have an Exchange Server 
account, your EMS data is kept on the server. Do not copy your OST file—a 
new one will be created on your new computer.

2. Copy any PST files that you use.

3. Copy your Outlook settings files.
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4. Run Outlook and re-create your profile settings (this will give you access 
to your EMS). When you run Outlook for the first time, a wizard will help 
you enter your profile settings. If you had more than one profile on your 
old computer, you will need to manually re-create the other profile 
settings on your new computer using the Mail applet in the Windows 
Control Panel.

No E-Mail support. Users with No E-Mail support need to take the same steps 
as those with Internet Mail Only support.

Moving from One Exchange Server Account to Another.

In the rare case where you need to move from one Exchange Server account to 
another (e.g., when your server or username changes), keeping an OST is not 
the proper way to backup your data while you switch accounts. Each OST is 
linked to your particular EMS file, so you will not be able to synchronize your 
original OST with your new EMS. In this case, you should export your entire EMS
to a backup PST. If any data is lost in the subsequent move to your new 
Exchange Server account, you can then Import your data from the backup PST 
into your new EMS file.
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Archiving
The longer you use Outlook, the more items accumulate in your folders. And as 
the number of items in your folders increases, it can take more time to perform 
certain operations. Finding items in a folder will be slower when there are more 
items to search through, and switching to your Calendar will take more time 
when there are more appointments to display. If you are an Exchange Server 
user, you might also find that you need to limit the number of items in your data
file to keep your total file size under a limit set by your server administrator.

There are many good reasons to keep the size of your data file under control, 
and the Outlook Archive feature helps you do this.

AutoArchive

Periodically, Outlook will show the following message, reminding you to clean out
the old items in your folders by running AutoArchive:

Figure 4. The AutoArchive prompt

If you agree to begin archiving, the AutoArchive feature goes through each of 
your folders one-by-one and searches for items that haven’t been used in a long 
time. When it finds them, it moves these out-of-date items into an archive PST 
file. This cleans the old items out of your current folders, storing them away for 
easy reference later on. 

Customizing AutoArchive

Outlook chooses default AutoArchive settings for you, but it’s always a good idea
to review them and make any necessary customizations before you perform your
first AutoArchive.

Global settings. To control how often to AutoArchive and what file to 
AutoArchive to, you can go to the AutoArchive options dialog box (Tools | 
Options | Other | AutoArchive).
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Figure 5. The AutoArchive global settings dialog box.

The key setting here is the default archive file location. This is the file that your 
old items will be archived to (with a few exceptions noted below). By default, 
this file is named Archive.pst, and is located in Outlook’s Local Settings directory
(“C:\Windows\Profiles\username\Local Settings\Application Data\Microsoft\
Outlook\”). 

Per-folder AutoArchive settings. If you want to set custom AutoArchive 
settings for each of your folders, you can go to the AutoArchive properties page 
for each folder (right-click on the folder, choose Properties, then go to the 
AutoArchive tab). When AutoArchive runs on each folder, it will look at these 
settings to determine which items to Archive and where to put them.
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Figure 6. Calendar AutoArchive properties.

In the dialog box above, the user has chosen to move any appointments that are
more than six months old into the specified archive PST file. The user could have
also chosen to permanently delete the old items instead of moving them into the
archive PST file (this is the default AutoArchive behavior for the Deleted Items 
folder).

Note  You will notice that you can enter a separate archive PST file location for 
each folder. Outlook will fill in this location for you by default, using the file 
location in your global AutoArchive settings. But be careful when changing your 
global AutoArchive file location, because the per-folder file location setting for a 
given folder will only change to match the global setting if you have never 
AutoArchive any items out of that folder. Once you AutoArchive any items from a
folder, the per-folder file location “sticks” and will not change to follow the global
file location setting.

If you never customize your per-folder AutoArchive settings, your folders will 
have the following default settings:

Folder AutoArchive 
on/off

Action Older than

Calendar, Journal, Tasks On Move 6 months
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Sent Items On Move 2 months

Deleted Items On Delete 2 months

Contacts Never archived

Inbox, Drafts, Outbox, 
Notes

Off Move 3 months

User-created folders Off Move 3 months

Contacts are never archived because Outlook does not record a “last viewed” 
time for each Contact. Outlook assumes that you will always need to access any 
of your Contacts. If you would still like to “archive” contacts that are out-of-date,
you can open your archive file (instructions below) and manually drag them into 
your archive folders.

Dates

The date used to determine when an item will be archived depends on the type 
of item.

Item type Archive date
E-mail 
message

The sent date, received date, or last modification date, 
whichever is later.

Appointment The appointment end date or the last modification date, 
whichever is later.

Task The completion date or the last modification date, whichever is
later. (Tasks that are not marked complete are not archived. 
Tasks assigned to others are archived only if marked 
complete.)

Note The last modification date.

Journal entry The date the journal entry was created or the last modification
date, whichever is later.

Contact Never archived.

Opening an Archive File

If at any time you need to access items that have been archived, simply open 
the archive PST using the File | Open | Personal Folders File command. Make 
sure your Folder List is visible (View | Folder List), then you will be able to see 
both the archive file and your current data file. You can now search through your
archive folders to find old items, open up and edit those items, and even copy 
them back into your current data file. 
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Figure 7. Archive folders listed in the Folder List.

Note There is nothing special about an archive PST that makes it any different 
than a regular PST. All PSTs have the same file format, and you can move items 
and folders in and out of them interchangeably.

Manual Archive

If you wish to manually archive items from a folder, you can use the Archive 
dialog box (File | Archive). This dialog box lets you archive any items in the 
selected folder (and subfolders) older than the date you give.
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Figure 8. The Archive dialog box.

To archive an entire folder, you can set the archive date to the current day. This 
is a great way to archive a project folder once the project has been completed.

Synchronizing Folders Between Computers

Synchronizing Your Personal Folder File (PST)

In Outlook 97 and Outlook 98, there was no way to synchronize the information 
in one PST file with a PST file on another computer. But now this is possible in 
Outlook 2000 with the new Personal Folder Synchronization add-in. 

Note  Personal Folder Synchronization is currently in its beta phase. It will not 
ship with Outlook 2000, but will be available for download on the Microsoft Web 
site (http://microsoft.com/outlook) soon after Outlook 2000 is released.

Once installed, Personal Folder Synchronization lets you save the latest changes 
from your office computer to a synchronization file. This file can be saved to 
your hard drive or a network share, or it can be split across a set of floppy disks.
When you open this file on your home computer, the contents of your folders will
be updated. If there are any conflicts, Outlook gives you the opportunity to 
resolve them. After working for a while on your home computer, you can then 
save a return synchronization file to bring any changes you’ve made back to 
your office computer.

http://microsoft.com/outlook
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Synchronizing Your Office PST with Your Home PST

Using disks. If you want to synchronize the folders on your office computer with
those on your home computer, you can use floppy disks to transfer your 
synchronization file. Outlook will save the minimum amount of information 
necessary to communicate the latest changes, but in some cases this will require
more than one disk. If you have a ZIP drive or other high-capacity medium, you 
can also use this to save your synchronization files. 

Using a RAS connection. If you have a Remote Access Server (RAS) 
connection to your office network, you can keep your computers synchronized 
without carrying disks back and forth. Just save your synchronization file to a 
shared directory at the office, and download it from home.

(Using e-mail—not recommended). It is not recommended that you e-mail 
synchronization files as attachments between your office and home computers. 
Synchronization files can be very large, and as such the messages may be 
rejected by your e-mail server.

Note  if you have an e-mail account at home that is different from your account 
at work, you can always use Net Folders to share folders between your office and
home accounts. Net Folders doesn’t let you share your Inbox or Outbox, but it’s 
a good solution if you need, for example, to share a Contacts folder.

Synchronizing Your Office EMS with Your Home PST

Without RAS. If you can’t connect to your Exchange Server via a RAS network 
connection, then you can use Personal Folder Synchronization to synchronize 
your EMS folders at the office with your PST at home. In this case you can use 
floppy disks, ZIP disks, or other high-capacity media, just as you would if you 
had a PST at the office instead of an EMS.

The Personal Folder Synchronization add-in will not allow you to synchronize 
Exchange Server Public Folders. 

With RAS. If you can dial into your EMS with a RAS connection from home, then
you will not need to use Personal Folder Synchronization—you should instead 
use Exchange Server offline folders to keep a local OST file on your home 
computer and synchronize it periodically with your Exchange Server.

How Personal Folder Synchronization Works

Personal Folder Synchronization works by taking a “snapshot” that catalogs all of
the items in the folders you want to synchronize on the office computer. Each 
time you save a new synchronization file, Outlook compares the current contents
of the selected folders with the last snapshot. If any items have been created, 
deleted, moved, or modified, Outlook will save this information in the 
synchronization file. Outlook will also include the current snapshot in the 
synchronization file, so that the destination computer can double-check that it 
isn’t missing any items.

Tip  With Personal Folder Synchronization it’s a good idea to bring 
synchronization files back and forth between both computers as consistently as 
possible. This is because the source computer will keep sending the old 
synchronization information until it gets a return synchronization file from the 
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destination computer. If you only save synchronization files in one direction (i.e.,
from the office to home only) the synchronization files will get larger and larger.

Skipping synchronization files. This feature does not, however, require that 
you keep a strict “office to home, then home to office” routine. Personal Folder 
Synchronization keeps sending the same information until it hears a response, 
so if you ever lose or skip a synchronization file all you have to do is save 
another one and it will contain all of the skipped information. You can even 
“cross” synchronization files, or read them in out of order (while this is not 
encouraged, the worst outcome will be item modification conflicts). And if at any
point your data is badly out of sync, all you need to do is perform a full 
“roundtrip”—office to home, then home to office—to fully synchronize your 
folders. 

Synchronizing multiple computers. Personal Folder Synchronization will let 
you keep more than two computers synchronized, but you must make sure to 
synchronize them in a “hub” configuration, with one central source computer 
that synchronizes with several destination computers. You should never use a 
“web” configuration, where destination computers also synchronize with one 
another, because this will generate duplicates of all of your items. It’s a good 
idea to limit the number of computers that you keep synchronized, since each 
new computer you add requires keeping an additional “snapshot” in your central 
computer, and these snapshots can be large depending on how many folders you
keep synchronized.

Synchronizing Your Exchange Folders Between Computers

Keeping Local Copies of Your Exchange Server Folders: Offline Folders

Users of the Outlook messaging and collaboration client running against an 
Exchange Server can take advantage of its rich synchronization features. If you 
have an EMS mailbox, you can keep an offline copy of your Exchange Server 
folders (both private mailbox folders and Public Folders) in an Offline Folder file 
(OST). You can then work from your Offline Folders just as you would while you 
were connected to your Exchange Server. When you connect again, any changes
that you’ve made will be synchronized with your Exchange Server folders, and 
vice versa. This is an ideal configuration for laptop users.

To choose which folders to make available for offline use, go to the Tools menu, 
choose Synchronize, and then choose Offline Folder Settings. This new dialog 
box lets you check off the folders that you want to be available offline (as well as
other synchronization settings).
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Figure 9. The Offline Folder Settings dialog box.

If you’re on the road, or working from home, you can also configure Outlook to 
automatically dial up your Exchange Server and synchronize your folders on a 
regular schedule. You can set your synchronization schedule on the Mail Services
tab of the Tools | Options dialog box, and you can set your Exchange Server 
dial-up settings in your Exchange Server properties dialog box (Tools | Services 
| Microsoft Exchange Server Properties | Dial-Up Networking).

Sharing Folders with Other Users

Sharing Folders Using Net Folders

The Net Folders feature lets you automatically share information from your 
computer across the Internet. You can share folders with other users without 
having an Exchange Server or file server. For example, you can use Net Folders 
to share Outlook folders (Calendar, Contacts, etc.) from your computer to any 
other Outlook user anywhere. You can also broadcast messages to a group of 
people in much the same way as an e-mail list server does. 

When you use Net Folders to share a folder, a copy of the shared folder appears 
in the Outlook Folder List of everyone who subscribes to the folder. For example,
if you share a folder called Crandall on your computer, everyone who subscribes 
to that folder will have a Crandall folder added to their Folder List. Any item you 
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put in the Crandall folder on your computer is automatically sent to the Crandall 
folder of all of the subscribers. If you modify an item in the Crandall folder, the 
changed item is updated for all of the subscribers. Net Folders can be used to 
share messages, calendars, tasks, contacts, or any other Outlook item.

The owner of the shared folder assigns a permission level to each subscriber that
determines how they can work with items in the Net Folder. For example, the 
editor permission level allows a subscriber to add new items or change existing 
items in a Net Folder. Items changed by subscribers are updated in the original 
folder and in all subscriber folders. 

Net Folders works by sending hidden messages back and forth between the 
owner and the subscribers. Whenever the owner (or a subscriber with editing 
permissions) changes items in the folder, updates are silently sent to all of the 
subscribers. If the subscribers are Outlook users, these hidden e-mail messages 
will cause the items in the folder to be automatically updated. You can share e-
mail messages with subscribers who do not use Outlook, but they receive these 
items in their Inbox, and subscriber folders are not created. Outlook items other 
than e-mail messages (such as Calendar items or contacts) are not usable by 
other e-mail programs. Special folders such as the Inbox, the Outbox, any 
Exchange Server folders, and any Exchange Offline Folders cannot be shared 
using Net Folders.

Sharing Folders Using Microsoft Exchange Server

Outlook users running against an Exchange Server can take advantage of rich 
collaboration and information sharing features.

Public Folders

Public folders let users share information with other users on their Exchange 
Server. Users (or their server administrator) can add a folder to the Public 
Folders directory, and its items can be viewed and edited by other users. 
(Administrators can of course assign various permission levels to their users.) 
Public folders can be used as project folders, shared contact lists, discussion 
forums, group calendars, etc. They can also be used to house custom forms 
applications. 
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Figure 10. This folder list shows the user’s public folders tree, including the “Crandall 
Project” folders, and a shared “Group Contacts” folder. The user has also chosen three of 
these public folders as “Favorites.”

If you want to work with your favorite public folders while you aren’t connected 
to your Exchange Server, you can keep offline copies of them in an OST file, just
as you would with the private folders in your EMS mailbox. To do this, first add 
the public folder to your list of public folder favorites, either by dragging the 
folder from its original location into your “Favorites” tree, or by selecting the 
folder and choosing File | Folder | Add to Public Folder Favorites. Then choose 
Tools | Synchronize | Offline Folder Settings and select the folders that you 
would like to be available offline.

Delegates

The Delegate feature allows a user to manage other people’s Exchange Server 
folders from within Outlook (for example, an assistant would use this feature to 
coordinate a manager’s schedule).

After the manager sets the assistant as a delegate from the manager’s 
computer, all meeting requests sent to a manager also appear in the assistant’s 
Inbox. The assistant can accept meetings, enter appointments, and organize 
meetings on the manager’s behalf.
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Figure 11. A manager has set Sean Purcell as a delegate (from the Delegate tab of the 
Tools | Options dialog box) and has chosen various permission levels for each folder.

Once the manager has set a user as the delegate, the delegate can then open 
any of the manager’s accessible folders by choosing File | Open | Other User’s 
Folder.

Frequently Asked Questions

Is archiving the same thing as backing up?

No. Archiving takes old items and moves them into a separate archive file. 
Archiving is a tool for cleaning up and organizing your folders, not for making 
backup copies of them.

What’s the difference between archiving and exporting to a PST?

Archiving moves items into another data file, removing them from the current 
data file. Exporting puts copies of items into another data file.

How do I find out how large my Outlook data file is?

Right-click on the root folder and choose Properties. In the Properties dialog box,
click the Folder Size button. This will calculate the total size of the data file, as 
well as the size of each subfolder.
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If your data file is a PST, you can also look at its raw file size with the Windows 
Explorer, just as you would with any other file. Note that the raw and calculated 
file sizes of a PST are not always identical.

What is the default Outlook data file (where is my new mail being 
delivered)?

The default data file is the file that new mail is being delivered to. You will also 
only receive reminders from items in the Calendar, Contacts, Inbox, and Tasks 
folders in your default data file. In the Folder List, the default data file will have 
the special Outlook Today icon and will have “Outlook Today” displayed in front 
of its name. 

Internet Mail Only support. In Internet Mail Only support, you can change 
your default data file by right-clicking on the new file’s root folder and choosing 
Properties. On the General tab of the Properties page, there is a checkbox that 
reads “Deliver POP mail to this personal folders file.” Checking this checkbox will 
set this as your default data file (you will first need to exit and restart Outlook 
for the change to take effect).

Corporate or Workgroup support. In Corporate or Workgroup support, you 
can change your default data file by going to the Tools menu and choosing 
Services. In the Delivery tab of the Services dialog box there is a “Deliver new 
mail to the following location” dropdown list. This will let you select your new 
default data file (you will first need to exit and restart Outlook for the change to 
take effect.)

While all Exchange Server users have an EMS file on the server, some users 
choose to set a local PST as their default data file. This causes all new mail to be
delivered to the PST on their computer. Keeping your information on your local 
hard drive generally results in faster performance (especially if you have a slow 
network connection to the server) and will also let you avoid the EMS size limits 
set by your server administrator. The drawback, however, is that you cannot 
take advantage of Exchange Server synchronization and folder sharing on your 
PST folders. 

What is the “root folder”?

The root folder of a data file is the topmost folder of the data file, containing all 
of the subfolders.
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Figure 12. “Archive Folders” is the root folder of the archive PST, and “Outlook Today – 
[Mailbox – Sean Purcell]” is the root folder of the Exchange Server mailbox. 

Are PST and OST files automatically compacted?

No. But Outlook lets you compact these files manually. This does not change the
file format in any way, it simply compacts the data files as efficiently as possible 
so that they will take up less space on your hard disk.

Compact a PST. Find the PST file in your folder list, right-click on the root 
folder and choose Properties. In the Properties dialog box, click the Advanced 
button, then click the Compact Now button. 

Compact an OST. Find your Exchange Server mailbox in the folder list, right-
click on the root folder and choose Properties. Click the Advanced button to get 
to the Microsoft Exchange Server properties dialog box. From here, go to the 
Advanced tab and click the Offline Folder File Settings button. Then click the 
Compact Now button.

For more information: http://www.microsoft.com/office/ 

   

http://www.microsoft.com/office/
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